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1Introduction 

This document introduces the DVS software of CLIPSTER and the 
Pronto series and provides a first approach to their most important 
functions. You may use it to make yourself acquainted with the soft-
ware’s structure and the way it operates. 

Most users would want to work with the DVS system right away and 
do not require in-depth descriptions. Therefore, this guide often just 
shows how to access individual functions and features of the soft-
ware. With this you will know where to find these functions and you 
may be able to start your work immediately. 

 

Whenever more information is needed, please consult the 
other guides delivered with the system. They provide detailed 
descriptions and explanations about the functions and fea-
tures of the software. 

1.1 CLIPSTER or Pronto Series Only 

The software of CLIPSTER and the Pronto series use an almost identi-
cal user interface. The main difference lies within their feature sets. 
While CLIPSTER operates mostly in digital intermediate processes, the 
systems of the Pronto series are usually used as fast digital disk re-
corders with basic conforming capabilities. 

This guide describes the interfaces of both systems. The optional or 
exclusively available features will be marked with the following: 

 

 
This feature is available for CLIPSTER only. 

 
This feature is available for a system of the Pronto se-
ries only. 

Option 
An added Option below the symbols indicates that this 
feature is optionally available for the respective system.
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1.2 Preparations 

To follow the descriptions in this document your CLIPSTER or Pronto 
series system has to be prepared in some ways: 

− To use the Edit Tool or Spycer at least one clip should be available 
on the drive for video material (usually V:\). Either copy clips (im-
age sequences) to this drive or record them from an externally 
connected player with the I/O Tool (see next point). 

− To record with the I/O Tool an external player (e.g. VTR) should 
be connected to the DVS system properly. Interconnect at least the 
video in- and outputs and the remote control ports. Afterwards, if 
set up correctly, you can record clips from the external device. 

1.3 Starting the Software 

Start the software either via the START button menu of Windows 
(e.g. All Programs » DVS » Clipster) or via its icon on the desktop: 

 

Example of a desktop icon to start the DVS software 

1.4 The Software Modules 

The software of CLIPSTER and the Pronto series consists of several 
programs and modules that combined allow you to process digital 
video and audio in real time for almost any application. The following 
lists the most important program modules available on your system: 

Software Module Short Description 

Edit Tool This software module enables you to edit video 
material. You can arrange clips of all formats 
and resolutions in any sequence on a timeline. 
Afterwards, they can be edited with the pro-
vided feature set, e.g. with hard cuts, transitions 
or effects. This software module is automatically 
active after the starting of the software. 



 Introduction 
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I/O Tool With this software module you can capture 
video and audio material from telecines, VTRs, 
digital disk recorders, or even cameras either in 
an automated batch processing mode or manu-
ally. In its Batch record mode it supports fully 
the use of EDLs or cut lists. 

Integrated Spycer Spycer, the content management software by 
DVS, comes free with your system and is inte-
grated into the software’s user interface as a 
software module. It provides you with browse, 
search and management tools to retrieve data 
and gather information about them locally as 
well as via a network. Additionally it can be used 
to preview audio, video as well as other data 
and add clips to the bin of the software to make 
them available for your project. 

Configuration Tool This software module allows you to configure 
and set up the DVS system and its software. 
With it you can, for example, set the period for 
the automatic save function of the project file 
(autosave) as well as more software specific set-
tings, such as the bin properties. 

 

All software modules can be accessed easily with the help of the task 
bar of the software’s user interface (bottom left: buttons EDIT, I/O, 
SPYCER, and CONFIG…): 

 

Task bar of the software 

1.5 ProntoXway 

The ProntoXway is DVS’s multi-channel disk recorder. It provides the 
features as described in this document for the Pronto series and, fur-
thermore, offers two totally independent video channels in one sys-
tem. 

Each video channel can be controlled independently from the other 
with its own user interface. They are also independent from the soft-
ware module or operation mode (record/play-out) used, and can ac-
cess either the same or different material (shared storage). 
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For stereoscopic applications the two channels can be synchronized 
and controlled from one channel. For this you have to use the multi-
device operation mode which can be set up via the Configuration 
Tool of the DVS software (Options » Defaults… » group VTR, see 
also section “Configuration Tool” on page 5-1). 

 

The multi-device operation mode is a standard feature of the 
ProntoXway. For all other DVS systems it is optionally avail-
able. 
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2Edit Tool 

The Edit Tool of the DVS software enables you to edit video material. 
You can arrange clips of different formats and resolutions in any se-
quence on a timeline. Afterwards they can be edited with the pro-
vided feature set, e.g. with hard cuts, transitions or effects. This soft-
ware module is automatically active after the starting of the software. 

 

Overview of the Edit Tool 

2.1 Adding Clips to the Bin 

Before clips can be arranged on the timeline the bin has to be filled 
with clips. These clips will then be available for your project. There are 
several ways to add clips to the bin: The best and most informative 
way is to use Spycer (see section “Adding Clips to the Bin Using Spy-

tool area 
with bin

video time-
line track

control area 
with overlay

audio time-
line tracks
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cer” on page 4-4), but they can also be added by using a file man-
ager: 

 

Audio clips to be used in your project must be added to the 
bin the same way as video clips. 

• Press [Windows ( ) + E] on your keyboard to open the Windows 
Explorer. 

• Afterwards browse for a clip and drag and drop it to the bin: 

 

Drag and drop from file manager 
 

This will add the clip to the bin and a thumbnail view of the video clip 
will be visible in the bin’s contents area. 

2.2 Adding Clips to the Timeline 

When clips are available in the bin, they can be added to the video 
track of the timeline: 

 

Audio clips can be added to the timeline (i.e. to the audio 
tracks) the same way as video clips. 

• Drag and drop a clip from the bin to the video track of the time-
line: 
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Drag and drop from bin 
 

This will add a representation of the video clip to the timeline. 

2.3 Working with Clips in the Timeline 

The timeline of the Edit Tool can be used most intuitively. In the fol-
lowing you can find some information how to operate with clips in 
the timeline: 

 

Described in the user guide of the Edit Tool there are several 
more ways to work with clips in the timeline, e.g. slip and 
slide trimming or 3-point editing. 

− Usually the timeline cursor indicates the position of the frame cur-
rently displayed in the video overlay as well as at the output of the 
DVS system. It may also be used to determine certain positions 
when editing in the timeline. 

− For your work in the timeline there is an insert or overwrite mode 
available (toggle button INSERT/OVERWRITE). The insert mode will 
preserve your timeline contents (e.g. when adding clips), while in 
the overwrite mode clips may be overwritten. 

− Clips can be moved in the timeline by taking them up with the 
mouse and dragging them to a new position. 

− Clips can be deleted from the timeline by selecting them and press-
ing the keyboard key [Del]. 
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− When selecting the starting/end point of a clip, a yellow handler 
will appear enabling you to trim the respective clip, i.e. to change 
its in- or outpoint on the timeline. 

− Clips in the timeline can be cut, copied or pasted as usual under 
Windows. 

− A clip can be split into two or more parts (separate clips) by setting 
a cutting point. This can also be used to trim a clip. Move the time-
line cursor to the position where the cutting point should be ap-
plied and press the button + EDIT. Afterwards you may delete a 
separated part of the clip. 

− To define a certain range of the timeline you can apply an in- and 
outpoint for the timeline (In: , Out: ). 

2.4 Adding Effects to the Timeline 

There are several features available that enhance the capability of the 
DVS system. 

2.4.1 Cropping the Timeline 

You can crop the contents of your timeline with the but-
ton SETTINGS… located in the timeline area. It will open 
the video output settings window (see “Playing Out the 
Timeline” on page 2-7) where you can find at the bottom right, be-
sides other possible timeline configurations, the settings to crop the 
timeline: 

 

Further timeline configurations 
 

A click on the button CROPPING… opens the dialog window where 
you can set a cropping of the timeline: 
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Timeline cropping window 

2.4.2 Setting Transitions in the Timeline 

When at least two clips are present in the timeline that provide heads 
and/or tails (trimmed in-/outpoints), you can add a transition: 

• Move the timeline cursor to a cutting point between two clips (e.g. 
with  / ). 

This will make the button TRANS available in the timeline area of the 
Edit Tool. 

• Select the button TRANS. 

A transition will appear between the two clips: 

 

Transition between clips 
 

To configure the transition double-click it in the timeline which will 
call up the properties of this transition. 
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2.4.3 Timeline Element Properties 

In general, timeline element properties are used to deter-
mine the appearance of elements in the timeline (e.g. 
video clips and transitions). With them you can, for in-
stance, add various effects to video clips in the timeline (effects op-
erators). The following effects may be available on your video system: 

Effects Operator Short Description 

1st Color Correc-
tion 

This operator offers a primary color/gamma cor-
rection for video clips as well as an assignment 
of static look-up tables (LUTs) to the clips. 

2nd Color Correc-
tion 

Provides a vector-based secondary color correc-
tion which allows you to color correct video clips 
with several definable color vectors. 

6-Vector CC Offers six predefined colors for a selective color 
correction enabling you to manipulate the color 
values defined by the selected vector. 

Flip/Flop This operator enables you to mirror the video 
images vertically and/or horizontally. 

Zoom + Pan Allows to set zooming and/or panning for video 
clips. It is by default available for all clips in the 
timeline. 

DeInterlace This operator renders a clip from an interlaced 
image format to a progressive one. 

Accessing/Closing the Timeline Element Properties 

To access or close the timeline element properties double-click a time-
line element in the timeline or select from its context menu the menu 
option Show properties. 

When accessed, the timeline element properties will be visible instead 
of the audio tracks right below the timeline area. They will show the 
properties of the element that is currently selected in the timeline. 

Adding an Effect 

To add an effect to a video clip in the timeline perform the following: 

• Select the video clip that should receive an effect on the timeline. 

• Activate the tab Effects in the tool area of the Edit Tool. 

• Select from one of the folders the operator that should be applied 
to the clip and drag and drop it to the Effects list of the timeline 
element properties: 
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Drag and drop of effect 
 

This will add the effect to the Effects list of the clip. Its properties will 
be displayed in the settings pane of the timeline element properties 
where they can be adjusted. 

2.5 Playing Out the Timeline 

Once your work in the timeline is done, it can be played out, for ex-
ample, via the SDI ports (serial digital interface) of the DVS system. 
To view the timeline contents, for instance, on a monitor connected 
to the SDI output(s) perform the following: 

• Access the video output settings with the button SETTINGS… in 
the timeline area of the Edit Tool. 
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Output settings 
 

• Select and configure the output according to the device connected 
to the output(s), and confirm your settings with the button OK. 

• Then select in the control area the play button ( ). 

This will start a play-out of the timeline. If your output settings are 
correct, the signal will be received at the device connected to the out-
put(s). 

2.6 Finalizing 

A prepared timeline can be finalized to any file format and resolution 
you want. Afterwards it will be available with all effects applied to the 
timeline as a new clip (image sequence) on the storage. Furthermore, 
video and audio can be finalized separately: 

• To finalize and render a new clip from the timeline use the menu 
option Project » Finalize…. 

• In the opening window configure the video and/or audio settings 
according to your prepared timeline and the clip to be finalized. 

• Then confirm your settings with the button RENDER. 

This will render the timeline to the stated location. 
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3I/O Tool 

The I/O Tool of the DVS software enables you to record video and 
audio material from telecines, VTRs, digital disk recorders, or even 
cameras either in an automated batch processing mode or manually. 
In its Batch record mode it supports fully the use of EDLs or cut lists. 

 

Overview of the I/O Tool 
 

All task modes available in the I/O Tool can be accessed easily via the 
task mode buttons of the user interface. 

tool area

control area 
with RS-422 

controls

task mode 
buttons

selection 
area
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3.1 Capturing Clips 

Capturing clips is one of the main functions of the I/O Tool. For this 
the I/O Tool provides three different record modes: 

Record Mode Short Description 

Manual This mode is used to perform a crash record in 
the I/O Tool. 

Autoedit Allows to perform a record from a connected 
external player. Here you can set an in- and 
outpoint as well as a duration for the record. 

Batch This mode is used to process EDLs, cut lists or a 
proprietary capture list of the I/O Tool. With it 
you can perform several different record opera-
tions from various sources in one step. Addition-
ally, you can perform an autoconforming by 
building up a timeline in the Edit Tool from a 
given batch list. 

 

 

The Batch record mode is mentioned here for sake of com-
pleteness. For information about how to use it please consult 
the user guide of the I/O Tool. 

 

The record modes can be accessed via the task mode 
buttons of the I/O Tool’s user interface. 

 

3.1.1 General Settings 

To perform a record operation you first have to make a set of settings 
in the selection area of the I/O Tool which will be identical for all re-
cord modes: 

• Specify the video and/or audio format for the clip to be captured. 
The set video format has to match the incoming signal, i.e. it must 
be of the same format and raster. 

 

Items to set the video and audio formats 
 

• Select the type of material that you want to capture: audio or 
video alone, or audio together with video. For this activate the but-
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ton VIDEO and/or the audio channel buttons of the audio channels 
that you want to record. 

 

Items to set the record type 
 

• Specify where to save the clip, i.e. enter the clip’s name, its direc-
tory path as well as a path where to file the clip(s) in the bin (in 
case folders are present in the bin). 

 

Items to determine the paths 
 

• Set other more file related storage information, such as the file 
format, the saving type or the color space range. 

 

Items to set more file related storage information 
 

As soon as all of the above said is done, you have to set the mode 
specific settings for the respective record mode as described in the 
next sections. 

3.1.2 Manual Record Mode 

The Manual record mode ( ) can be used to perform a 
crash record with the I/O Tool. After the general settings (see 
“General Settings” on page 3-2) are made in the selection area of the 
Manual record mode, you can initiate a crash record at any time by 
pressing the button RECORD in the lower right corner of the selection 
area. 
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The I/O Tool then performs the record and the video overlay shows 
the signal present at the system’s input. To terminate the manual re-
cord you have to press the RECORD button again. 

 

With a set duration in the field Dur prior to a record, you can 
set the total record time to be captured by the I/O Tool: 
Once the recorded clip amounts to the stated duration, the 
record will stop automatically. 

3.1.3 Autoedit Record Mode 

With the Autoedit record mode ( ) you can perform a re-
cord from an external player connected via RS-422. For this you have 
to set the inpoint, outpoint and duration of the clip to be captured: 

• After the general settings are made in the selection area of the 
Autoedit record mode (see “General Settings” on page 3-2), use 
the RS-422 controls of the control area to go to the exact inpoint 
in the material of the externally connected player. 

• Then press the IN button in the selection area to set the inpoint of 
the I/O Tool to the selected position. 

• After that use the RS-422 controls to move the external player to 
the desired outpoint in the material. 

• Then click the OUT button. 

In-, outpoint and duration (In, Out and Dur) should now be set in the 
selection area of the Autoedit record mode. 

• Next press the RECORD button at the bottom right of the selection 
area to start the record operation. 

The I/O Tool then performs the record in accordance with your set-
tings: The video overlay switches to the live signal present at the sys-
tem’s input and the external player starts its play-out. As soon as the 
inpoint is reached the record is performed up to the out-
point/duration where the record will be terminated automatically. 

3.1.4 Batch Record Mode 

With the Batch record mode ( ) you can perform several 
different record operations from various sources in one step. It sup-
ports the use of EDLs, cut lists or a proprietary capture list of the 
I/O Tool. 

Additionally, you can perform an autoconforming in this mode by 
building up a timeline in the Edit Tool from a given batch list. 
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The Batch record mode is mentioned here for sake of com-
pleteness. For information about how to use it please consult 
the user guide of the I/O Tool. 

3.2 VTR Task Mode (VTR Emulation) 

The I/O Tool provides a VTR emulation mode that mim-
ics the behavior of a logical VTR. With this feature the 
DVS system can be used as a VTR or digital disk recorder 
and you can easily record material on the timeline of this mode and 
play it out afterwards. 

• Click the button VTR ( ) of the task mode buttons to 
switch to the VTR task mode. 

Afterwards you have to create a new VTR timeline to use the VTR 
task mode: 

• Select Project » New which will open the specification window of 
the VTR timeline. 

 

VTR timeline base settings 
 

Option



CLIPSTER / Pronto Series Software Starter Guide 

3-6  

• In this window configure the VTR timeline to your liking. Make 
sure that at least the input settings match your project’s needs be-
cause a change of some of them will not be possible afterwards. 

Once the VTR timeline base settings are confirmed, the selection area 
of the I/O Tool shows you the 24 h timeline of the VTR: 

 
 

 

24 h VTR timeline 
 

To the left you can find the position settings of the I/O Tool’s VTR 
timeline. The L buttons ( ) have to be used to activate the in- and 
outpoint of the timeline. To the right you can find the position set-
tings of the external device connected via RS-422. 

The EDIT/MANUAL button is a toggle button that switches between 
an autoedit (control of an external device via RS-422) and a manual 
(crash record) mode for the VTR task mode. 

 

Before recording or playing out with the VTR task mode you 
have to make the same general settings as for a record op-
eration (except for paths and storage settings which were al-
ready set with the VTR timeline base settings; see “General 
Settings” on page 3-2). 

The output video raster is usually locked to the input raster. 
To configure an output differently from the input settings 
they have to be unlocked (check box Lock to Input). 

3.3 Playing Out Clips 

The Play-out task mode ( ) allows you to play out clips 
with the I/O Tool. 

VTR timeline (local) external device 
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Selection area of the Play-out task mode 
 

With it you can, for example, play out clips present in the timeline of 
the Edit Tool (either in a manual or in an autoedit mode): 

 

Before playing out with the Play-out task mode you have to 
make almost the same general settings as for a record opera-
tion, i.e. you have to define a video output format and set a 
play-out type (see “General Settings” on page 3-2). 

With the Play-out task mode you can also play out single 
clips that are present in the bin. Information about this can be 
found in the user guide of the I/O Tool. 

• Prepare or load a timeline in the Edit Tool. 

• In the selection area of the Play-out task mode select from the 
Autoedit/Manual combo box whether you want to perform a si-
multaneous record with an externally connected device via RS-422 
(Autoedit) or not (Manual). 

• If you want to record your play-out with an external device, you 
have to set the in-, outpoint and duration with the In, Out and 
Dur items. 

• After that press the button PLAY in the lower right corner of the 
selection area. 

The I/O Tool then performs the play-out and shows the contents of 
the Edit Tool’s timeline in the overlay as well as at the system’s out-
put. If the autoedit mode was selected, the external device will start a 
record of the material at the specified inpoint. 
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4Spycer 

Spycer, the content management software by DVS, is integrated into 
the DVS software’s user interface as a software module. It provides 
you with browse, search and management tools to retrieve data and 
gather information about them locally as well as via a network. Addi-
tionally it can be used to preview audio, video as well as other data 
and add clips to the bin of the software to make them available for 
your project. 

 

Overview of Spycer 

4.1 Enabling the SpycerNet 

One strong point of Spycer is the software’s capability to enable a de-
centralized content management as soon as several Spycer applica-
tions operate combined in a network. Then they form the SpycerNet, 

bin

metadata 
area

preview area

browse and 
search area
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a scalable distributed content management network, where you can 
gather information about or search for material that is stored on other 
workstations. Each Spycer installed in the network maintains a data-
base containing information about the contents locally stored. This in-
formation is then accessible and can even be edited from any work-
station in the SpycerNet. 

However, ex factory Spycer normally is configured to display the ma-
terial which is stored locally only, i.e. it is set to the localhost address 
(127.0.0.1). To enable a network communication between Spycer 
applications you have to set another IP address via the configuration 
settings of the DVS software (Options » Defaults… » group Spycer 
General, see also section “Configuration Tool” on page 5-1). 

4.2 Browsing and Searching 

With the browse and search area you can browse local or network 
storages or perform searches. 

4.2.1 Browsing 

An activated button BROWSE at the top of the browse and search 
area displays two browsing panes in the area: 

Browsing panes 
 

The two browsing panes enable you to copy or move data between 
different locations easily via drag-and-drop procedures. Additionally, 
you can perform directory and file related tasks here by using the 
context menu of an item (e.g. create, delete or rename files and/or 
directories). 
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4.2.2 Searching 

The button FIND at the top of the browse and search area switches to 
the search tool of Spycer: 

The search tool 
 

With the search tool you can find any material by combining various 
search parameters, such as file names or metadata information. Once 
the search location and the search parameters are set, a click on the 
button FIND IT! will display the search results in the results area. 

4.3 Viewing Data and Metadata 

As soon as material is displayed in the browse and search area it can 
be viewed in the metadata and preview area. Simply double-click a 
file with the mouse or select it and press [Enter] to view additional in-
formation about it: 

Metadata and preview area 
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To the left you will then see the metadata of the material. With the 
buttons FILE, HEADER DATA and PRODUCTION you can view more of 
them, while the buttons EDIT, SAVE and CANCEL allow you to edit 
them. 

 

Some metadata are provided for review purposes only and 
cannot be edited because they are direct properties of the re-
spective file. Furthermore, only the header data of *.dpx 
files edited with Spycer will be saved together with the files. 
All other edited metadata will be provided virtually by Spy-
cer’s database only. 

To the right you can find the preview area which can be used to pre-
view 3D LUT files, still images and video clips. By creating and using 
proxy clips, video material can also be played. Audio clips can be 
played in the preview area as well. 

 

To create a proxy clip use the menu option Create proxy on 
the context menu of a video clip in the browse and search 
area. Once the creation of the proxy clip is finished, it can be 
used for playing. 

4.4 Adding Clips to the Bin Using Spycer 

Spycer can also be used to add clips to the contents area of the bin. 
When clips are displayed in the browse and search area (see section 
“Browsing and Searching” on page 4-2), they can be dragged and 
dropped into the contents area of the bin: 
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Drag and drop to bin 
 

This will add the selected clip to the contents area of the bin. 

4.5 Managing Data 

For further management tasks besides copying/moving data or ad-
justing their metadata, Spycer offers a lot of tools. Most of these can 
be accessed via the context menu of an item displayed in the browse 
and search area: 
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Context menu of a file 
 

Among others the following tools are provided: 

High-speed copying Copies large amounts of data from one stor-
age location to another in about four times 
the speed of a standard operating system 
copy. 

Defragmenter Defragments any kind of data and addition-
ally optimizes the physical alignment of image 
sequences on the storage for optimal real-
time performance. 

Renaming of image 
sequences 

Changes, for instance, the name prefixes, 
frame numbers or file extensions of image 
sequences. 

File format converter Converts still images as well as complete 
video clips to other file formats. 

Scheduler Initiates, for example, copy, defragment or 
delete tasks at certain times or intervals 
automatically (e.g. for management and 
maintenance operations in the SpycerNet). 

 

 

The scheduler cannot be accessed via a context menu, but 
with the button SCHEDULER below the menu bar. 
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5Others 

The DVS software provides other modules or useful features, some of 
them will be sketched in this section. 

5.1 Configuration Tool 

The Configuration Tool allows you to configure and set up the DVS 
system and its software. With it you can, for example, set the period 
for the automatic save function of the project file (autosave) as well 
as more software specific settings, such as the bin properties. 

It provides overall two configuration groupings to define project re-
lated settings or default settings that will be used for the DVS system 
in general as well as for each new project. 

The Configuration Tool can be accessed via the task bar of the soft-
ware’s user interface (button CONFIG…): 

 

The Configuration Tool 
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5.2 Slave Mode 

The DVS system usually operates as a master. Nevertheless, in the fol-
lowing modes it can be used as a slave via RS-422 as well: 

− Edit Tool 
The timeline of the Edit Tool is controlled from the external master. 

− I/O Tool – Manual record mode 
A record is controlled from the external master. 

− I/O Tool – Play-out task mode 
The timeline of the Edit Tool is controlled from the external master. 

− I/O Tool – VTR task mode 
Record as well as play-out of the VTR timeline is controlled from 
the external master. 
 

The slave mode can be activated by pressing the SLAVE… button 
( ). Then commands for record, play, stop, jog, or shuttle can be 
sent via RS-422 and will be carried out by the DVS system. 

Normally, the system can no longer be controlled from its user inter-
face when in slave mode, only the master can control it. To enable 
minimal control of the system without relinquishing the slave mode, 
some modes display a slave mode control window: 

              

Examples of slave mode control windows 

5.3 Pulldown 

Pulldown is needed when working with film-originated material. The 
pulldown feature offers a film-to-NTSC conversion: It renders video 
data that is in 24 progressive frames/sec (film) as 30 interlaced 
frames/sec (NTSC). 

The pulldown feature of the DVS software can be accessed when you 
want to in- or output video material, for example, during the settings 
of the video format (button VIDEO FORMAT… in I/O Tool or SET-
TINGS… in Edit Tool, see figure in section 5.4 on page 5-3): 
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Pulldown settings 

5.4 Variframe 

When recording material with the I/O Tool the DVS 
software offers you the possibility to record video mate-
rial from particular cameras that support Variframe. 

Such cameras send their video data with higher frame rates, e.g. 50 
or 60 Hz, and to have it properly recorded, for example, in 24 Hz, 
certain frames (the frames to be recorded) have to be tagged by the 
camera. If the Variframe feature is enabled in the software, only the 
tagged frames will be recorded by the DVS system. 

The Variframe feature can be set in the video format settings when 
capturing video data: 

 

Video format input settings 
 

 

Option
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Headquarters:  

DVS Digital Video Systems AG 
Krepenstr. 8 
30165 Hannover 
GERMANY 

Phone: +49-511-67807-0 

Fax: +49-511-630070 

E-mail: info@dvs.de 

Internet: http://www.dvs.de 
 

Support:  

Phone: +49-511-67807-25 

Fax: +49-511-67807-31 

E-mail: support@dvs.de 
 

 

 

 

 

 

For the Americas:  

U.S. Headquarters:  

DVS Digital Video, Inc. 
300 East Magnolia Boulevard, Suite 102 
Burbank, CA 91502 
USA 

Phone: +1-818-846-3600 

Fax: +1-818-846-3648 

E-mail: info@dvsus.com 

Internet: http://www.dvsus.com 
 

Support:  

E-mail: support@dvsus.com 
 

mailto:info@dvs.de
http://www.dvs.de/
mailto:support@dvs.de
mailto:info@dvsus.com
http://www.dvsus.com/
mailto:support@dvsus.com
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